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ACCESSING THE CHEMICAL LAB

Launch a web browser application.

If the application does not open a new browser window by default,
you must open a new window manually.

1.

Load the IrYdium website:
http://ir.chem.cmu.edu/irProject/applets/virtualLab/

You may receive a new URL from your professor.

Single click the “Run the applet” link located on the bottom of
the window.

The server will auto-detect information about the computer you are
working from and download the appropriate files for your machine.
You will merely identify yourself as a novice user and click “Continue”
through several pages.

3.

2.

NOTE: If you have any problems locating the lab, please
email help@ir.chem.cmu.edu



RETRIEVING A SOLUTION

In the “Stockroom Explorer” window, locate the directory called
“IrYdium Solutions.”

In this directory, you will see a list of many solutions.  If you do not
see the list, single click on the small key icon to the left of the
directory name, “IrYdium Solutions,” and the solution list will be
displayed.

Single click the solution you wish to add to your workbench.

Once you select a solution, a description of the solution will appear in
the bottom window of the Stockroom Explorer (i.e., 10M HCL is
described as a “Strong Hydrochloric Acid”).

Single click the “Add Solution” button on the action bar,
located on the left-hand side of the active workbench.

An Erlenmeyer flask will appear on your workbench, labeled with
the name of the solution.

2.

3.

1.

HINT: You may want to use stock solutions anytime
you begin a new experiment.
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NOTE: You must have at least one flask on your active
workbench.

REMOVING A FLASK

1.

Single click the “Remove” icon on the action bar, located on the
left-hand side of the active workbench.

The flask will disappear.

2.

Single click the flask you want to remove.

The outline of the flask will change from black to a light blue and the name
of the flask will become highlighted.
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OBTAINING GLASSWARE

Single click the “Add Glassware” icon in the action bar, located
on the left-hand side of the active workbench.

The icon is the third one in the list.  When your pointer sits on top of
the icon, a pop-up menu appears with the message, “Click to select
new glassware from the drop-down menu.”

1.

Drag the pointer down to the type of glassware you want and
single click.

The list will disappear, and the glassware will appear on the active
workbench.

2.

HINT: You may want to use new glassware to mix your
solutions.



RELABELING A FLASK

With the right mouse button, single click the flask you want to
rename.

The outline of the flask will change from black to a light blue, the
name of the flask will become highlighted, and a pop-up menu will
appear.

Drag the pointer down to the option, “Relabel,” and single click
with the left mouse button.

A “Relabel Solution” dialog box will appear.

Type the new label for your solution and single click “Ok.”

The dialog box will disappear and the flask will bear the new label.

2.

3.

1.

NOTE: You must have at least one flask on your active
workbench.
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SELECTING A TRANSFER MODE

Single click the “Tools” menu, located above the Stockroom
Explorer window.

The “Tools” menu contents will be displayed.

Drag the pointer down to the option, “Transfer Bar.”

A submenu will appear, listing two options (precise transfer or realistic
transfer).

Drag the pointer over to the desired option, either “Precise
Transfer” or “Realistic Transfer,” and single click the
highlighted option.

The dialog box will disappear and the transfer bar located below
the active workbench will reflect the selected option.

2.

3.

1.

NOTE: You should use realistic transfer mode to
simulate the precision possible in an actual lab.
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NOTE: You must have at least one solution and one
flask on your active workbench.

POURING A SOLUTION (PRECISE TRANSFER)

1.

In the Transfer Bar field located beneath the active workbench,
type the amount of source solution (in mL) you want to pour
into the recipient flask and hit return.

In the Solution Information window, the volume of the recipient
solution will increase to reflect its new volume.  If you single click on
the source flask, you can see an equivalent decrease in the volume of
the source solution.  All changes in the concentration and/or pH are
updated instantly.

3.

Single click the solution you want to pour.

The outline of the flask will change from black to a light blue and the
name of the flask will become highlighted.  This flask is known as the
“source flask” for the transfer.

Single click and drag the source flask on top of the flask in
which you want to pour the solution -- release the mouse
button when the recipient flask outline changes from black to
light blue.

The source flask will become tilted above the “recipient flask”  (the
one receiving the liquid) and the outline of the recipient flask will
return to black.

2.
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POURING A SOLUTION (REALISTIC TRANSFER)

Single click the flask of the solution you want to pour.

The outline of the flask will change from black to a light blue and the
name of the flask will become highlighted.  This flask is known as the
“source flask” for the transfer.

1.

Click and hold on the “Pour” button located beneath the active
workbench for as long as you wish to pour source solution into
the recipient flask.

As you hold the Pour button, the amount of solution actually poured
is shown to the left of the Pour button.  Please note, however, that
this ‘counter’ resets itself each time you click on the pour button.  You
will need to refer to the Solution Information window to determine the
amount of solution in the recipient flask or click on the source flask
and refer to the Solution Information window to determine the amount
of solution in the source flask .  All changes in the concentration and/
or pH are updated instantly.

3.

NOTE: You must have at least one solution and one
flask on your active workbench.

Single click and drag the source flask on top of the flask in
which you want to pour the solution -- release the mouse
button when the recipient flask outline changes from black to
light blue.

The source flask will become tilted above the “recipient flask”  (the
one receiving the liquid) and the outline of the recipient flask will
return to black.

2.



NOTE: You must have at least one solution, one flask,
and one pipette on your active workbench.

TRANSFERRING WITH PIPETTE     (PRECISE TRANSFER)

1.

Single click and drag the pipette on top of the recipient flask to
which you want to add the solution -- release the mouse button
when the recipient flask outline changes from black to light
blue.

The detail view will still appear.

3.

Single click and drag the source flask from which you want to
withdraw the solution on top of the pipette to fill the pipette --
release the mouse button when the pipette outline changes
from black to light blue.

The detail view of the pipette will appear.

In the Transfer Bar field located beneath the active workbench,
type the amount of source solution (in mL) you want to with-
draw with the pipette and hit return.

In the Solution Information window, the volume of the pipette will
increase to reflect its new volume.  If you single click on the source
flask, you can see an equivalent decrease in the volume of the source
solution.  All changes in the concentration and/or pH are updated
instantly.

2.

In the Transfer Bar field located beneath the active workbench,
type the total volume of the pipette to transfer its contents to
the recipient flask and hit return.

In the Solution Information window, the volume of the pipette will
decrease to reflect its new volume.  If you single click on the recipient
flask, you can see an equivalent increase in the volume of the
recipient solution.  All changes in the concentration and/or pH are
updated instantly.

4.
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TRANSFERRING WITH PIPETTE     (REALISTIC TRANSFER)

NOTE: You must have at least one solution, one flask,
and one pipette on your active workbench.

1.

Single click and drag the pipette on top of the recipient flask to
which you want to add the solution -- release the mouse button
when the recipient flask outline changes from black to light
blue.

The detail view will still appear.

3.

Single click and drag the source flask from which you want to
withdraw the solution on top of the pipette to fill the pipette --
release the mouse button when the pipette outline changes
from black to light blue.

The detail view of the pipette will appear.

Click the “Pour” button located beneath the active workbench for
as many times as you need to withdraw the appropriate
amount of source solution from the flask into the pipette.

In the Solution Information window, the volume of the pipette will
increase to reflect its new volume.  If you single click on the source
flask, you can see an equivalent decrease in the volume of the source
solution.  All changes in the concentration and/or pH are updated
instantly.

2.

Click and hold the “Pour” button located beneath the active
workbench until all of the solution in the pipette has been
added to the recipient flask.

In the Solution Information window, the volume of the pipette will
decrease to reflect its new volume.  If you single click on the recipient
flask, you can see an equivalent increase in the volume of the
recipient solution.  All changes in the concentration and/or pH are
updated instantly.

4.
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HEATING A SOLUTION

NOTE: You must have at least one solution and the
bunsen burner on your active workbench

1. Single click and drag the flask you want to heat on top of the
bunsen burner.

The flask will become centered above the flame, and the tempera-
ture will begin to rise on the thermometer, located to the right side of
the active workbench (above the pH meter).

Single click on the Bunsen Burner, and single click the up or
down arrow to increase or decrease the flame.

As you click the up arrow, the flame will increase, and as you click the
down arrow, the flame will decrease.

2.



12

STORING A SOLUTION

Single click the folder in your account folder where you want to
store your solution.

The folders within your account are denoted by the “open door” icon,
a rectangle with two shades of purple.  If you attempt to store a
solution in something other than a folder, you will get a “Store Error”
message.

Single click the solution you wish to store in your account.

The outline of the flask will change from black to a light blue and the
name of the flask will become highlighted.

Single click the “Store Solution” button on the action bar,
located on the left-hand side of the active workbench.

The solution will not disappear from your workbench, but you will
have a copy of the solution in your account.

2.

3.

1.

NOTE: You must have logged into a user account and
have a solution on your active workbench.



SELECTING A WORKBENCH

Under the active workbench, single click on a tab (i.e., Work-
bench 2 or Workbench 3, etc).

The new workbench will appear, and the tab you selected will
become a lighter shade of gray than the other tab options.

1.

HINT: Select a new workbench if your current one is
crowded or you are doing multiple experiments.
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ADDING A WORKBENCH

In the File menu, select “New Workbench.”

Another tab, entitled “Workbench 4,” will be added to the bottom of
your workbench area.  You will have to single click on the tab to
make the new workbench the active workbench.

1.

HINT: Create a new workbench if your current ones are
crowded and you need clean workspace.
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